Evaluating opportunistic sighting records of large whales around South Georgia Island:
Changes in distribution, relative abundance, and species composition of sightings and the efficacy of reporting methods

By: Jessica Richardson
Dr. Douglas Nowacek, Advisor
May 2012

Masters project submitted in partial fulfillment of the requirements for the Master of Environmental Management degree in the Nicholas School of the Environment of Duke University

2012
Abstract
To examine general population trends of large whales in South Georgia waters, two opportunistic
data sets of large whale sightings from 1991-2010 around South Georgia were analyzed: the
South Georgia Museum log of whale sightings and British Antarctic Survey whale sighting
reports from the Bird Island research station. Bird Island abuts the Northwest tip of South
Georgia. The four most-reported species for both data sets were southern right whale
(*Eubalaena australis*), humpback whale (*Megaptera novaeangliae*), minke whale (*Balaenoptera
acutorostrata*), and killer whale (*Orcinus orca*). These totally independent data sets showed
comparable changes in abundance through time, thus despite a lack of sighting effort records,
inferences could be made about changes in relative abundance.

The number of reported sightings per 5-year period from both data sets increased from the 1991-
1995 period through the 2001-2005 period and has since decreased. Species composition of
reported sightings has changed over time; southern right whales have become the most sighted
species for both data sets with a peak of reported sightings in the 2001-2005 period. Sightings
are concentrated around Shag Rocks, at the northwest tip of South Georgia, and along the
north/east coastline of South Georgia; sightings in the bays around South Georgia have increased
over time. In an area such as the Antarctic with many difficulties associated with conducting
research, opportunistic data sources such as these can become invaluable. Although
opportunistic data are not ideal, the ability to obtain data that would otherwise be unattainable
may make these data sources quite useful.

The reporting method for whale sightings at South Georgia was in desperate need of updating
and the historical records were underutilized. To remedy this, I created a web form to report
sightings linked on an interactive web map that allows users to view sightings of a selected
species over a selected date range. The reporting process is now digital, and past sightings can
now be viewed interactively by the public. The web map and form have been uploaded to the
South Georgia Heritage Trust web site for use. The South Georgia Museum and South Georgia
Government web sites have also been asked to include a link to the web map.
# Table of Contents

SECTION 1: Changes in the distribution, abundance, and species composition of large whales around South Georgia ................................................................. 1

Introduction ................................................................................................................................. 1
Background ........................................................................................................................................ 3
  South Georgia Island Ecology ..................................................................................................... 3
  Whaling ........................................................................................................................................ 4
Government ..................................................................................................................................... 6
  International Legislation ............................................................................................................. 7
  National Legislation .................................................................................................................... 8
Methods ....................................................................................................................................... 10
  Museum Log Data ...................................................................................................................... 10
  Bird Island Data .......................................................................................................................... 12
Results ......................................................................................................................................... 13
Discussion ..................................................................................................................................... 16
Conclusions .................................................................................................................................. 19

SECTION 2: Evaluating and updating sighting reporting methods in South Georgia ............... 20
Introduction .................................................................................................................................... 20
Methods ....................................................................................................................................... 24
  New Report Form ....................................................................................................................... 24
  Interactive Web Map .................................................................................................................. 24
  User Manual ................................................................................................................................ 25
Results/Discussion ....................................................................................................................... 25
Conclusions .................................................................................................................................. 29

Acknowledgements ................................................................................................................... 30
Literature Cited ............................................................................................................................. 31
Appendix I: Google Spreadsheet/Form and Google Fusion Table ................................................. I
Appendix II: HTML/JavaScript Code for Web Page ................................................................. IV
Appendix III: Web Page User Manual ....................................................................................... XII
SECTION 1: Changes in the distribution, abundance, and species composition of large whales around South Georgia

Introduction

South Georgia waters were perhaps the most whale dense habitat on the planet 100 years ago; over a 7 year period from 1923-1930, harvests of 1 to 1000+ fin whales (*Balaenoptera physalus*) and 1 to 990+ blue whales (*B. musculus*) were reported from single 261mi² areas (Figure 1) [1].

South Georgia waters are characterized by high biomass and productivity of phytoplankton, zooplankton, and vertebrate predators. Although the causes of this productivity remain unclear despite studies dating back over a century, commercial fisheries have exploited the abundant resources since the late 1700s [2]. The most notable exploitation in South Georgia waters is that of the large whale populations. In 1903, Norwegian whaler C.A. Larsen noted “[they are very big whales and I saw them in the hundreds and thousands]” [3]. A year later Larsen returned to establish the first whaling station on South Georgia. After his highly successful first year, the desire to obtain whaling permits and establish stations on South Georgia intensified; by the 1912-13
season, six stations were operating on the island and South Georgia had become known as the southern capital of whaling [3-5].

Historically, whaling is characterized by a progression from more valuable or more easily caught species to less attractive species as stocks of the original targets became depleted [5]. Antarctic whaling is no exception. Catches throughout the Antarctic can be divided into five periods: humpback whales from 1904-1912; blue whales from 1913-1937; fin whales from 1937-1965; sei whales from 1965-1975; and minke whales from 1975-present [3]. While other species were caught during each period, the named species represented the targeted species that was the bulk of the catch. Southern right whale (*Eubalaena australis*) stocks were depleted in the southern hemisphere by the mid-19th century, before whaling stations were established on South Georgia, so they comprised only a minimal portion of catches [5].

The 61-year period of whaling in South Georgia waters (1904-1965) spanned through the first three “periods” of Antarctic whaling: humpback whale, blue whale, and fin whale. Catches at South Georgia included: blue (*Balaenoptera musculus*), fin (*B. physalus*), sei (*B. borealis*), humpback (*Megaptera novaeangliae*), minke (*B. acutorostrata*), southern right (*E. australis*) and sperm (*Physeter macrocephalus*), most of which were depleted to less than 10% of their original stock size [3, 6, 7]. When whaling ceased in South Georgia in 1965, a reported 175,250 whales had been processed at the land-based whaling stations alone since 1904 [3, 8-25]; over 2 million whales were taken in the Antarctic between 1900 and 2005 [7].

Decades later, sightings are still relatively rare and little is known about the populations [25-27]. This lack of knowledge stems from the inherent difficulty associated with studying cetaceans in the Antarctic; research in the area is quite costly and sighting conditions are often

---

1 Minke whales recorded may have also been of the species *Balaenoptera bonaerensis*
unfavorable. Due to these difficulties, opportunistic data may be useful in lieu of quantitative line transect studies to examine broad trends in large whale populations over time. Independent, continuous, historical data sets are kept of opportunistic sightings around South Georgia by the South Georgia Museum and the British Antarctic Survey station at Bird Island. These data sources have little to no direct cost and, despite a lack of sighting effort data and study design, may illustrate general population trends for large whale species in South Georgia waters. This paper presents findings from the analysis of these two opportunistic data sets.

Background

South Georgia Island Ecology

South Georgia Island is a small, isolated, sub-Antarctic British territory located about 1,550km from the nearest point on the Antarctic continent. It is the second largest of the sub-Antarctic islands with a total land area of 3,755km² composed of the main island and multiple small islands, islets, and rocks that are included in the territory [28]. Antarctic krill, *Euphausia superba*, dominate the pelagic invertebrate community in the seas around South Georgia, accounting for around half of the biomass. They form the diet of many of South Georgia’s other marine organisms, including baleen whales (Mysticetes) [4]. Until the advent of whaling, the Southern Ocean contained more large whales than any other ocean in the world. In particular, South Georgia waters contained large numbers of blue (*Balaenoptera musculus*), fin (*B.physalus*), sei (*B. borealis*), humpback (*Megaptera novaeangliae*), minke (*B. acutorostrata*) and southern right (*Eubalaena australis*) whales during the austral summer, sustained by the large krill production in the area [4].
Several species of toothed whales and small cetaceans (Odontocetes) also occur in South Georgia waters including sperm whales (*Physeter macrocephalus*), killer whales (*Orcinus orca*), long-finned pilot whales (*Globicephala melas*), hourglass dolphins (*Lagenorhynchus cruciger*), and several species of beaked whale (Family Ziphiidae) including southern bottlenose whales (*Hyperoodon planifrons*). These species probably rely upon pelagic fauna, such as squid and fish. Presently, pods of sperm whales and killer whales often associate with Patagonian toothfish (*Dissostichus eleginoides*) long-lining fishery operations; both species take toothfish off the lines [4].

**Whaling**

Historically, there have been multiple important commercial fisheries based at South Georgia Island since the late 1700s, including the unsustainable whaling industry in the early to mid-20th century [2, 3, 29]. In 1904, Norwegian whaler C.A. Larsen established the first land-based whaling station on South Georgia Island at Grytviken on November 16, 1904 [4, 29]. His enterprise was quite successful, leading to great interest in obtaining whaling licenses to harvest from South Georgia Island waters and a rapid increase in the whaling industry [29]. By the 1912-13 season, six stations were in operation on the island, most of which were shore-based; South Georgia Island had become known as the southern capital of whaling [4, 29].

The British government was able to regulate whaling at South Georgia Island and ensure its sustainable management for some years through restricting the number of whaling licenses issued, prohibiting the exploitation of right whales and whales accompanied by calves, requiring all parts of the whale to be used, and levying a duty on the produced oil [4]. However, companies seeking to avoid restrictions and the duty on oil along with the increasing scarcity of
whales in the near-shore waters of South Georgia Island and technological advances led to the advent of pelagic whaling in Antarctic waters in the late 1920s [4, 29]. Whaling on the high seas was not subject to licensing restrictions, regulations on what whales could be taken, or the duty on oil. The lack of regulation led to great reductions in the populations of large whale species around South Georgia Island and in the Southern Ocean in general [4].

Whale populations in South Georgia Island waters became so scarce that whaling ceased in this region in 1965 after only 61 years of whaling; this cessation occurred 21 years before the International Whaling Commission’s moratorium on commercial whaling [7, 29]. In the few decades of whaling at South Georgia Island, a reported 175,250 whales were processed at the land-based whaling stations alone [29]; between 1900 and 2005, over 2 million whales were reported taken in the entire Antarctic [7] (Table 1). Populations of all exploited species were reduced to less than 10% of their original size, some to less than ~1% [4]. This massive reduction occurred due to unsustainable catches combined with the low reproductivity rates of baleen whales; in general, baleen whale females only produce a calf every 2-3 years [30].

| Table 1. Southern Hemisphere whaling catch totals 1900-2005 [7] |
|-----------------|------------------|
| Blue            | 362,770          |
| Fin             | 725,331          |
| Sei             | 203,843          |
| Humpback        | 3                |
| Minke           | 119,415          |
| Southern Right  | 4,424            |
| Sperm           | 405,898          |
| Other           | 19,716           |
| **TOTAL**       | **2,054,642**    |

At present, 46 years after the cessation of whaling at South Georgia Island, populations of most of the exploited species are still a small fraction of pre-exploitation abundances [4]. Some of these populations may be slowly recovering, but the extent of recovery is unknown as there is
little to no knowledge regarding most of the large whale populations around South Georgia Island [4, 25].

**Government**

As a British territory, all policies and legislation stem from the British government with the Queen as head of state. Policies and legislation are passed down through the Cabinet, Prime Ministers, and Foreign and Commonwealth Office to the South Georgia Island Government, which is housed mostly in Stanley in the Falkland Islands—over 900 miles away [31] (Figure 2).

![Figure 2. Structure of the overall South Georgia and South Sandwich Islands Government with respect to the United Kingdom [31]](image)

The Government of South Georgia and South Sandwich Islands is headed by the Commissioner who has vested in him legal, financial, and administrative authority and responsibility for governance of the territory; currently the Commissioner is also the Falkland
Islands Governor. A Chief Executive Officer deals with policy matters and is the Director of Fisheries. The Executive Officer addresses tourism and expeditions and manages fishery patrols and the Environment Officer oversees environmental issues. A Financial Secretary and Attorney General hold similar appointments in the Falkland Islands’ Government. Finally, there are Government Officers in residence on South Georgia Island who are the government’s representatives and have responsibility for local administration and serve as Harbor Master, Customs and Immigration Officer, and Fisheries Officer. Three Government Officers rotate 8-month tours, overlapping so that there are always two in post on South Georgia Island [31] (Figure 3).

![Figure 3. Structure of the South Georgia and South Sandwich Islands Government][31]

**International Legislation**

The United Kingdom was signatory to the International Convention for the Regulation of Whaling in 1946 as part of the International Whaling Convention (IWC). Commercial whaling
is now prohibited by the IWC moratorium on whaling and the Southern Ocean, including the area around South Georgia Island, was designated as a whale sanctuary in 1994 by the IWC [4]. South Georgia Island is also subject to the Convention on Trade in Endangered Species of 1973 (CITES), which provides for the control of the importation and exportation of endangered species (such as large whales). Finally, the United Kingdom is signatory to the Convention for the Conservation of Antarctic Marine Living Resources (CCAMLR), which regulates fisheries activities in Antarctic waters including those around South Georgia Island [4].

While these conventions provide the potential for protection of large whales in South Georgia waters, international legislation has no single over-arching authority with the ability to sanction independent from individual nations. In most cases the enforcement is left up to the flag country, which charges South Georgia Island, and the United Kingdom in a broader sense, with enforcement of these conventions. International laws that are successfully sanctioned tend to coincide with national legislation with the same rules and objectives.

National Legislation
Prior to 1985, the Falkland Islands Dependencies Conservation Ordinance of 1975 provided for the designation of protected areas on South Georgia Island and for regulations to protect the flora and fauna. This ordinance also made it an offense to kill, wound, capture, molest or export any native mammal or native bird [4, 28]. However, in 1985 the South Georgia and South Sandwich Islands Order terminated their status as dependencies of the Falkland Islands and made them a separate territory of the United Kingdom—this made the Falkland Islands Dependencies Conservation Ordinance no longer applicable to South Georgia [32]. In 1989, the South Georgia and South Sandwich Islands Territorial Sea Order extended the territorial boundaries of South
Georgia Island to include as territorial sea the sea situated within 12 nautical miles of the baselines—baselines are defined as a series of straight lines joining specified points around South Georgia Island and other islands in its immediate vicinity [32]. Further, in 1993 a Maritime Zone Proclamation established a Maritime Zone for South Georgia Island having its inner boundary at the outer limits of the territorial sea (12 nautical miles) and its seaward boundary a line drawn so each point on the line is 200 nautical miles from the nearest point on the baselines. The Proclamation provides for regulation of activities within the Maritime Zone in accordance with international laws [32].

In May 2010, the Government of South Georgia and the South Sandwich Islands passed the Wildlife and Protected Areas Bill to provide protection to the terrestrial and marine flora and fauna on/around South Georgia and the South Sandwich Islands [33]. The bill prohibits certain methods of killing wild birds and mammals, restrict the introduction of non-native species, and allows for the creation of Specially Protected Areas (SPAs) and Marine Protected Areas (MPAs) through future ordinances. This bill applies throughout the internal waters, territorial seas, and Maritime Zone of the territories. Similar to the Falkland Islands Dependencies Conservation Ordinance of 1975, the Wildlife and Protected Areas Bill makes it an offense to kill, injure, capture, handle, or molest a wild bird or protected wild mammal [4, 33]. A permit system is also created within this bill to allow prohibited activities to occur with specific permission from The Commissioner [33].

In accordance with the Wildlife and Protected Areas Bill of 2010, The South Georgia and South Sandwich Islands Marine Protected Area Order was passed in February 2012. This order creates a Marine Protected Area (MPA) within the entire Maritime Zone and territorial seas of the South Georgia and South Sandwich Islands territory encompassing 1.07 million km² with
various levels of protection throughout—including 20.431km\(^2\) of no-take zones around the islands [34]. The MPA was created with objectives including: conserving marine biodiversity, habitats, and critical ecosystem function; ensuring that fisheries are managed sustainably, with minimal impact upon associated and dependent ecosystems; management of other human activities including shipping, tourism, and scientific research, to minimize impacts on the marine environment; facilitate the recovery of previously over-exploited marine species; and increase the resilience of the marine environment to the effects of climate change [34]. Some of the predominant restrictions within the MPA include: a ban of all commercial bottom trawling, careful regulation of fishing activity only allowed subject to licenses issued by the Government, and prohibition of disposal of plastic, fishing materials, or other inorganic waste into the marine environment [34]. This order provides various levels of protection for the myriad species throughout South Georgia Island waters, including the large whales that were previously over-exploited in these waters.

Methods

Museum Log Data

The South Georgia Museum in Grytviken was founded in 1992 by Nigel Bonner. Vessels of various types (e.g., fishery patrol, military, recreational, commercial fishing, cruise, research, etc.) that travel to South Georgia waters generally stop at Grytviken to clear into the port of entry, and in so doing often visit the museum where they are encouraged to record any whale sightings during their passage in the museum’s log book. This written log has been kept at the museum since December 1995; sightings from the logs of yachts, commercial cruise ships, and British Navy ships since 1992 have been appended to this written log resulting in almost two
decades of continuous sighting records. Sighting entries vary in detail and completeness but include some or all of the following information: sighting date, species, number of animals, observing vessel, vessel type, position coordinates of the sighting, description of the sighting location, and further comments about the sightings. Sightings are logged as sighting events; each event can include one or many individuals. Observers range from cruise passengers to seamen to military officials to naturalists, so the accuracy of species identification in this data set is often less than that from specifically trained marine mammal observers. All reports that indicated any uncertainty regarding the species identification were classified as “Unidentified”. Due to the difficulty of identifying beaked whales (Family Ziphiidae) to the species level, all beaked whales were grouped into a single category.

Reported sightings were georeferenced using GoogleEarth (earth.google.com) and ArcGIS 10 (ESRI, Redlands, CA, USA) based upon provided coordinates and/or location descriptions. Due to the variety in available data, some point locations are exact from given coordinates while others are more arbitrarily placed based on the given description of the sighting location. Entries with no location information or vague location descriptions were disregarded for spatial analysis. Sightings were organized by season, defined as periods extending from Aug to Jul (e.g., sightings from Aug 1991 through Jul 1992 were classified as the 1991 season). For analysis purposes, sightings were separated into four bins, each representing 5 seasons of data (1991-95, 1996-00, 2001-05, and 2006-10). Species composition, sighting locations, and overall sighting abundance was analyzed for variation over time.
**Bird Island Data**

Bird Island is a small island (4.8km long and up to 800m wide) that lies off the northwest tip of South Georgia Island (Figure 3). The British Antarctic Survey (BAS) has occupied a research base there every summer since 1975-6 and year-round since September 1983. There are typically 4 employees on station throughout winter (May to October) with up to 10 during the summer (November to April). Although the BAS scientific research at Bird Island focuses on seabirds and seals, incidental sightings of cetaceans are recorded in their unpublished annual report (Bird and Mammal Report, Bird Island, British Antarctic Survey). Sighting records in these reports are less descriptive, including sighting date and a written description of the sighting that notes the species seen, number of animals and other comments on the sighting. Annual reports are archived by the BAS and accessible by request; we acquired reports from the 1991 season through the most current report\(^2\) (2010 season) for comparison with the museum records. BAS observers are typically trained, professional field biologists, albeit not necessarily trained in large whale identification. Any uncertainty concerning species identification was recorded as “Unidentified”.

Since location information was absent or vague in many cases in the Bird Island records, these data were not georeferenced or analyzed for spatial trends. Sightings were organized by season and separated into temporal bins as described for the museum data. Species composition and overall sighting abundance was analyzed for variation over time. Trends in museum data were compared with those of the Bird Island data.

\(^2\) British Antarctic Survey Archives Service, Ref. no – AD6/2BI years 1991-2009
Copyright NERC/BAS
Results

The four most-reported species for the South Georgia Museum log and BAS Bird Island station records were southern right whale (*Eubalaena australis*), humpback whale (*Megaptera novaeangliae*), minke whale (*Balaenoptera acutorostrata*), and killer whale (*Orcinus orca*). Other reported species include beaked whales (Family Ziphiidae), blue whale (*B. musculus*), fin whale (*B. physalus*), hourglass dolphin (*Lagenorhynchus cruciger*), long-finned pilot whale (*Globicephala melas*), sei whale (*B. borealis*), and sperm whale (*Physeter macrocephalus*) (Figure 2). The number of reported sightings per 5-year period in both data sets increased from the 1991-5 period through the 2001-5 period and has since decreased (Figure 4-6). Species composition of reported sightings has changed over time. Southern right whales have become the most sighted species for both data sets with a peak of reported sightings in the 2001-5 period (Figures 6a and 6b). Other species have varied in relative sighting frequency over time and between data sets (Figures 6a and 6b). Sightings are concentrated around Shag Rocks, at the northwest tip of South Georgia, and along the north/east coast line of South Georgia (Figure 4). Sightings in the bays around South Georgia have increased over time; southern right, minke, and humpback whales have been reported in Cumberland Bay on multiple occasions in the past decade while there were no reported sightings of minke whales and very few of humpback or southern right whales there in the previous decade (Figure 4).
Figure 4. Whale sightings around South Georgia Island and Shag Rocks by species and season from 1991-2010. Species are denoted by symbols, time periods are denoted by color. Each symbol represents a single sighting event for one or many individuals. Bathymetric base map courtesy of Fretwell et al.
Figure 5. Total number of sightings of the four predominant species sighted plus unidentified sightings for both locations—*Eubalaena australis* (southern right), *Megaptera novaeangliae* (humpback), *Balaenoptera acutorostrata* (minke), and *Orcinus orca* (killer)—and unidentified sightings for four 5-year periods.

Figure 6. Number of sightings for each of the four predominant species—*Eubalaena australis* (southern right), *Megaptera novaeangliae* (humpback), *Balaenoptera acutorostrata* (minke), and *Orcinus orca* (killer)—and unidentified sightings for four 5-year periods for a) Bird Island and b) South Georgia Museum.
Discussion

Whale sighting records from South Georgia are a useful data source to illustrate general trends of the large whale populations in the area. It is important to note that these data are opportunistic and thus are accompanied by some shortcomings. There is no way to correct for effort with these data sets and species identifications may not always be accurate. Sighting abundance increased in both the BAS Bird Island Station log and the South Georgia Museum log from 1991 through 2005. Since these data sets are independent of one another—collected in different locations with different methods by different individuals—this change in sighting abundance must be effort independent to a significant degree. Thus, despite some limitations, we can still draw the following conclusions from the data: sightings of large whales have become more abundant around South Georgia since the 1990s; some species are beginning to reappear in bays around the island where sightings had previously been rare; and southern right whales (*Eubalaena australis*) have become the most frequently sighted species in the past decade.

The relative increase and then decrease in abundance seen in both data sets may be a result of population growth since the cessation of whaling coupled with environmental change driven distribution shifts, given that whale abundance around South Georgia has been known to fluctuate dependent on alterations in the environment [1]. Best [6] reported significant rates of increase in all monitored stocks of southern right whale (*E. australis*) [36-38] as well as 2 of the 3 monitored humpback whale (*Megaptera novaeangliae*) stocks in the southern hemisphere [39-42]—the third of which has only been monitored for a short time.

Whales have been more frequently reported within the bays along the South Georgia shoreline in the past decade than in the previous decade. At the onset of whaling, there was such an abundance of whales in the bay that boats could tow in four to seven whales daily, limited in
their catch by amount of daylight and processing time [3]. During the South Georgia whaling era, whales were predominantly caught within 10-40 miles of the shore [43]. Decades after the decimation of these near-shore populations of whales ended, individuals may finally be utilizing these bays again. Sightings are also concentrated around Shag Rocks as previously recorded by research cruises [e.g., 25], the northwest tip of South Georgia, and along the north/east shoreline of South Georgia. The concentration of these sightings is most certainly biased by the tracks of the ships—generally being tourist vessels coming from the Falkland Islands via the Shag Rocks to South Georgia and around the north/east shore of South Georgia often continuing on to the South Orkney Islands or South Shetland Islands (Figure 7).

![Figure 7. Typical route of cruise ships visiting South Georgia](image)

Southern right whales (*Eubalaena australis*) have become the most frequently sighted species in the past decade in both the BAS Bird Island Station and the South Georgia Museum log records. Because both information sources illustrate the same change in species composition of sightings, this has to be at least somewhat independent of changes in effort. Further, changes
in relative abundance are unlikely to be a result of effort variation as the likelihood of sighting one species versus another should be independent of effort. Moore et al. [25] also noted southern right whales as being the most frequently sighted species during a research cruise conducted in 1997 around South Georgia. Other previous studies report minke whales (*Balaenoptera acutorostrata*) as the most abundant/most frequently sighted species around the Antarctic [44, 45]. This shift in species composition may be attributable to the continued take of minke whales from the Antarctic [46] while southern right whale populations have been shown to have significant increase rates [6].

In this instance, opportunistic sighting records allowed us to determine general trends in the abundance, distribution, and species composition of the large whale populations around South Georgia. This data source is continuous for two decades and has little to no cost to use as sightings are recorded, logged, and maintained as part of various other funded activities. Similar studies have utilized ships of opportunity to conduct surveys when chartering a vessel for focused surveys was not an option [e.g., 47]. In an area with many difficulties associated with conducting research, such as the Antarctic, opportunistic data sources such as these can be invaluable. Although opportunistic data are not ideal, the ability to attain data that would otherwise be unattainable may make such data sources quite useful. Research, such as this, utilizing opportunistic data may also lead to further, more quantitative surveys that will provide a deeper understanding of these populations and help guide their protection through the Wildlife and Protected Areas Bill and the South Georgia and South Sandwich Islands Marine Protected Area Order—you cannot adequately protect something unless you understand it. Although the newly created MPA does provide protection for these populations, it is generalized to the whole
environment and does not/cannot consider specific protection needs of the previously over-exploited large whale populations to facilitate their recovery.

Conclusions

Large whale species that were depleted during the whaling era at South Georgia may be slowly recovering and returning. However, there is great need for better, more quantitative surveys around South Georgia to discover more about these populations. Due to the costs and difficulties associated with focused surveys in the Antarctic, a potential alternative could be using opportunistic vessels to conduct surveys. For example, trained marine mammal observers could be placed on cruise ships to get a more robust, effort-based data set of sightings or organized tourist group effort-based surveys could be conducted during cruises where tourists work with naturalists to keep an effort-based log of sightings. Opportunistic data and vessels may result in important findings that can shed more light upon the whale populations around South Georgia which may help motivate funding for future research surveys in the area and will help make the protection afforded to them by the new Wildlife and Protected Areas Bill and the South Georgia and South Sandwich Islands Marine Protected Area Order more effective.
SECTION 2: Evaluating and updating sighting reporting methods in South Georgia

Introduction

The South Georgia Museum in Grytviken was founded in 1992 by Nigel Bonner. In December 1995, the museum began keeping a written log of whale sightings reported by various vessels that stop to clear port of entry; a spiral notebook was placed in the museum for mariners to record any whale sightings during their passage (Figure 8). Entries in this log vary in detail based upon the reporter, with no universal format; they include some or all of the following information: sighting date, species, number of animals, observing vessel, vessel type, position coordinates of the sighting, description of the sighting location, and further comments about the sighting. In 2009, a report form was created to provide more structure to the records (Figure 9). This form provides spaces to report the sighting date, species, number of animals, observing vessel, observer, location description, latitude and longitude, and other notes.

The nature of this record makes reporting sightings an extra effort on the part of mariners who have limited time to spend in the museum while at Grytviken and may not bring detailed information about any sightings they may have recorded in their ship log. Further, it creates many obstacles for anyone who wants to acquire and utilize the data. To get the data, you have to contact the museum curator and ask them to take pictures of each page of the log and send the pictures to you, which is an inconvenience to all involved. Upon obtaining the data, the handwriting of the reports must be deciphered to enter the data into spreadsheets for analysis, which could introduce human errors associated with transcription and data entry. Due to these difficulties associated with using these data, it has essentially been sitting in the museum unutilized and collecting dust. This system is in desperate need of updating to make use of the
existing data, make reporting sightings easier, and make the data more easily available for use.

To accomplish this, I created a web form to report sightings linked on an interactive web map that allows users to view sightings of a selected species over a selected date range.
Nov 23/29 MV Multimorrey
- West Stag Rock - 2 separate encounters
  - 3 Fin Whales (x2)
  - 2 Sea Whales (x2)
  - 30 to 50 Long finned Pilot
  - 15 Humpback Dolphins
- 1 minke
- east of Stag - 1 Southern Right Whale
- Bird Island SE - 1 male Orca

27/11/05 1 WHALE SPECIES UNKNOWN
- Jacobson
- Bight

29/11/05 1 WHALE SPECIES UNKNOWN
- Cooper Sound

15/12/05 1 x Minke in Cumberland Bay West
- approx 0.45 (0) a beak
- ENDEAVOUR

21/12/05 1 x Orca 18 miles SE of Anneau Island from ENDEAVOUR (approx 18200)

25. December 2005 - MV REIGN 116 feet

5 January 2005 - Probable Southern Bottlenosed Whales west of Stag Rocks - Tender

10 January 2005 520 Southern Rights, during the same day also 200 Southern Bottlenose Dolphins and a few humpbacks East of Father to the wind we had one Blue whale

9 February 2006 Large group of Southern Right Whales (at least 6)
- east of Uhlaa Rocks

Figure 8. Photo of a page from the museum log pre-2009
<table>
<thead>
<tr>
<th>SIGHTING DATE:</th>
<th>8.12.09</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPECIES:</td>
<td>ORCAS</td>
</tr>
<tr>
<td>NUMBER OF ANIMALS:</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OBSERVING VESSEL (Name and type):</th>
<th>CLIPPER ADVENTURER</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBSERVER (Name and email address):</td>
<td>Michael Yolawski</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:mpolarnick@gmail.com">mpolarnick@gmail.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LOCATION (Description):</th>
<th>RIGHT WHALE BAY (ENTRANCE)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LATITUDE (S) &amp; LONGITUDE (W)</td>
<td>[Degree/minutes/seconds notation]</td>
</tr>
<tr>
<td>OTHER NOTES:</td>
<td>FEEDING TOGETHER WITH HUMPBACKS</td>
</tr>
</tbody>
</table>

Figure 9. Photo of a new page from the museum log adopted in 2009
Methods

Google was selected as the platform to host the sighting data and web map due to their freely available, user-friendly technologies that can be utilized in conjunction to yield the desired product.

New Report Form

Based upon a universal format a Google Spreadsheet was created to store reported data (see Figure A1, Appendix I). From this spreadsheet, a Google Form was created with required and optional data to report; entries are linked to corresponding columns in the spreadsheet. Required data includes: sighting date, species, number of animals, latitude, and longitude. Optional data includes: observing vessel, location description, and additional comments. This form is available via a link and can be emailed to users by the administrator—administrative power can be shared by the administrator to allow others to make changes, share the web form, etc.

Interactive Web Map

The interactive web map is based upon a Google Maps interface, drawing data from a Google Fusion Table. “Google Fusion Tables is a modern data management and publishing web application that makes it easy to host, manage, collaborate on, visualize, and publish data tables online” (docs.google.com)—they automatically interpret location information and allow for quick, easy mapping of data. A spreadsheet including all georeferenced whale sightings, organized by sighting year, was imported into a Google Fusion Table (see Figure A2, Appendix I) and the appropriate columns were identified as the location information. A column was added for symbology definition; each species was assigned a unique symbol for representation on
maps. This Google Fusion Table was then shared as “Unlisted” so that it could be referenced by the web map but was not released to be searchable to the public.

HTML and JavaScript coding was used to create the web map with the Google Maps API for JavaScript (see Appendix II). To incorporate the data points from the Google Fusion Table, a GoogleFusionLayer object was used, referencing the created Google Fusion Table. Within this object, simple queries were created using the ‘Where’ command to show only selected data points; selection menus were used to allow users to define the criteria by which the data is to be queried.

User Manual

A user-manual was written to allow a staff member at the museum take charge of the web page and Google documents for upkeep and updating purposes (see Appendix III). This manual explains the details of the HTML file so that any necessary changes to the web page can be easily made. The Google documents are also described in further detail to orient the museum staff to the documents and assist in quality control and updating procedures with the data.

Results/Discussion

The new reporting method allows users to report sightings anywhere with a working internet connection or email and removes the transcription and data entry steps from the process of using sighting data. Being able to send the form to mariners via email allows the potential opportunity to report sightings while at sea; many ships have intermittent email access during their passage. The web form requires the information necessary for future analysis to prevent data from being disregarded due to incompleteness while also providing space for other optional information
This method also maintains all sighting records in a single spreadsheet stored online, preventing the risk of losing the data to a computer crash. The separation of the form-linked spreadsheet and the Google Fusion Table storing the mapped data allows for quality control of reported sightings by the museum staff while maintaining compatible formatting for easy addition of new records to the Google Fusion Table and the web map. Data can also be easily queried and exported in the Google Fusion Table by the museum staff, which greatly increases sighting data availability.

The web map provides important public outreach for the museum; tourists and visitors are now able to see where whales have been sighted in the past (Figure 11). This also provides more incentive for mariners to record and report sightings. Previously, the records were not utilized which may have decreased the will of mariners to expend the extra effort to record and report
sightings. The map may become a part of the information given to potential cruise passengers to inform them about the areas and habitats they will visit.
Figure 11. Interactive web map of cetacean sightings around South Georgia Island from 1991-2011.
Conclusions

The reporting method for whale sightings at South Georgia was in desperate need of updating and the historical records were underutilized. The new web map and report form remedy these issues; the reporting process is now digital and past sightings can now be viewed interactively by the public. The web map and form have been uploaded to the South Georgia Heritage Trust web site for use. The South Georgia Museum and South Georgia Government web sites have also been asked to include a link to the web map.
Acknowledgements

I would like to extend a special thank you to Michael Moore for his guidance, advising, and help with this project; without him, this project would never have happened. My research would not have been possible without funding from the Woods Hole Oceanographic Institution/Duke University Fellowship Program. I would also like to thank Alison Neil of the South Georgia Museum and SGHT for providing sighting records from the museum’s log; Ellen Bazeley-White of the British Antarctic Survey Archives for providing sighting data from archived reports from Bird Island; John Fay for help with conceptualizing the web map; Elsa Davidson and Katie Murray of SGHT who helped acquire information; Richard McKee, Pat Lurcock and Sarah Lurcock of the South Georgia Island Government who contributed information about vessel and visitor statistics; British Antarctic Survey observers on Bird Island who contributed to the sighting records; and numerous observers on various vessels contributed to the museum log database. Carl Spielvogel assisted with museum log transcription. Peter Fretwell, Alex Tate, Tara Deen and Mark Belchier created the bathymetric grid used as a base map. I thank Peter Corkeron for his constructive review of the data. Finally, I would like to give special thanks to my Duke University adviser Doug Nowacek for his help and guidance throughout my time at Duke University.
Literature Cited


32. *Important Laws in South Georgia*. South Georgia and the South Sandwich Islands; Available from: http://www.sgisland.gs.


34. *South Georgia and the South Sandwich Islands Marine Protected Area management plan*, G.o.S.G.a.t.S.S. Islands, Editor 2012.


Appendix I: Google Spreadsheet/Form and Google Fusion Table
Figure A1. Google Spreadsheet linked to new reporting form
Figure A2. Google Fusion Table
Appendix II: HTML/JavaScript Code for Web Page
position: absolute;
top: 110px;
left: 15px;
font-family: "Trebuchet MS", Georgia, Serif;
font-weight: bold;
font-color: black;
font-size: small;
}
@end_date {
position: absolute;
left: 15px;
top: 155px;
font-family: "Trebuchet MS", Georgia, Serif;
font-weight: bold;
font-color: black;
font-size: small;
}
#link {
font-family: "Trebuchet MS", Georgia, Serif;
font-color: black;
font-weight: normal;
font-size: 14px;
text-align: left;
text-wrap: none;
position: relative;
top: 375px;
left: 15px
}
</style>
<!--EDIT THE TITLE BAR TEXT FOR THE WEB PAGE BELOW-->
<title>South Georgia Whale Sightings</title>
<!--DO NOT EDIT ANYTHING IN THIS SECTION!!!-->
<script type="text/javascript"
src="http://maps.googleapis.com/maps/api/js?sensor=false">
</script>
<script type="text/javascript">
function initialize() {
var tableId = 2935753
var locationColumn = 'Longitude (W)'
var latlng = new google.maps.LatLng(-54.268, -38.667);
var myOptions = {
zoom: 6,
center: latlng,
mapTypeId: google.maps.MapTypeId.SATELLITE
};
var map = new google.maps.Map(document.getElementById("map_canvas"), myOptions);
var layer = new google.maps.FusionTablesLayer(
    query: {
        select: locationColumn,
        from: tableId
    },
    map: map
);
google.maps.event.addDomListener(document.getElementById('Species'), 'change', function() {
    updateMap(layer, tableId, locationColumn);
});

function updateMap(layer, tableId, locationColumn) {
    var species = document.getElementById('Species').value;
    var startDate = document.getElementById('startYear').value;
    var endDate = document.getElementById('endYear').value;
    if (layer) {
        layer.setOptions(
            query: {
                select: locationColumn,
                from: tableId,
                where: "Species = " + species + " AND startYear >= " + startDate + " AND endYear <= " + endDate + ""
            }
        );
    } else {
        layer.setOptions(
            query: {
                select: locationColumn,
                from: tableId,
            }
        );
    }
}

google.maps.event.addDomListener(window, 'load', initialize, updateMap);
</script>
</head>
<!-END DO NOT EDIT SECTION-->
<!--BEGIN EDITABLE CONTENT-->
<!--CHANGE BACKGROUND COLOR BELOW ALONG WITH ABOVE IN STYLE PROPERTIES-->
<body style="background-color: #CCCCCC">
<body style="background-color: #CCCCCC">
<div id="header">
<!--EDIT THE WEB PAGE TITLE BELOW-->
South Georgia Island Cetacean Sightings 1991-2011

Species

--Select Species--

Beaked Whale
Blue Whale
Fin Whale
Hourglass Dolphin
Humpback Whale
Killer Whale
Long-Finned Pilot Whale
Minke Whale
Sei Whale
Southern Right Whale
Sperm Whale
Unidentified

Start Year

--Select Start Year--

1991
1992
1993
1994
1995
1996
1997
1998
1999
2000
2001
2002
2003
2004
<option value="2005">2005</option>
<option value="2006">2006</option>
<option value="2007">2007</option>
<option value="2008">2008</option>
<option value="2009">2009</option>
<option value="2010">2010</option>
<option value="2011">2011</option>
</select>
</div>
<div id="end_date">
<label>End Year</label>
<select id="endYear">
<!--ADD EACH NEW YEAR TO THIS SECTION-->
<option value="">--Select End Year--</option>
<option value="1991">1991</option>
<option value="1992">1992</option>
<option value="1993">1993</option>
<option value="1994">1994</option>
<option value="1995">1995</option>
<option value="1996">1996</option>
<option value="1997">1997</option>
<option value="1998">1998</option>
<option value="1999">1999</option>
<option value="2000">2000</option>
<option value="2001">2001</option>
<option value="2002">2002</option>
<option value="2003">2003</option>
<option value="2004">2004</option>
<option value="2005">2005</option>
<option value="2006">2006</option>
<option value="2007">2007</option>
<option value="2008">2008</option>
<option value="2009">2009</option>
<option value="2010">2010</option>
<option value="2011">2011</option>
</select>
</div>
<!--EDIT INSTRUCTIONAL TEXT IN LEFT PANE OF WEBPAGE BELOW-->

<!--DO NOT EDIT LINK TO SIGHTING REPORT FORM!!-->
<href="https://docs.google.com/spreadsheet/viewform?formkey=dGh0aFpQTmJQZ3RJT19abU9iOG9KT3c6MQ#gid=0">Report Sightings</a>
1. The Web Page

1.1. Overview
This site is created as an easy-to-use, interactive web map that allows anyone to visualize where whale sightings occurred based upon three input parameters: Start Year, End Year, and Species. It is composed of a simple HTML file that uses Google Maps as a mapping platform and references data stored in a Google Docs table.

There are three sections that need annual updating: the web page heading, the selection options for Start Year, and the selection options for End Year. See Section 1.4.3 and Section 1.4.4 below for more information on updating these.

1.2. Adding the page to an existing site
To add the page to an existing site, the HTML file should be uploaded to the webspace that houses the site. Once uploaded, the site should be ready to use and be accessed by its new URL (e.g. http://[existing site URL]/South Georgia.html)

1.3. Changing the URL extension for the page
To change the URL extension to access the page (currently .../South Georgia.html), change the HTML file name to “[desired URL extension].html”. Make sure to maintain the “.html” extension or it will not work.

Note: Any spaces in the file name will show up as “%20” in the address bar at the top of the browser.

1.4. Updating the HTML file
Please pay attention to comments (denoted by “<!--…--” tags) throughout the HTML file. Sections marked as DO NOT EDIT should be left alone. If there are issues with these parts of the file, please contact Jessica Richardson at richardson.jessica.lynn@gmail.com before making any changes. Sections open for editing are labeled and marked accordingly. Each editable section is discussed in further detail below.

Note: Before any changes show up on the webpage, they must be saved and the updated file must be uploaded. A good practice is to download a copy of the HTML file and save a local copy (in Downloads or on the Desktop) to make changes and check changes by launching the local copy of the file before uploading it to update the webpage. The best program to use for editing is the free source code editor Notepad ++ (download here: http://notepad-plus-plus.org/download). This program highlights tags to assist with editing HTML code and offers the option to launch the local file in a web browser from the program to see how your changes look before uploading the file and making it live on the web. To launch the local copy of the HTML file from Notepad++, save changes then go to Run>Launch in [desired browser]. Doing this prevents any
unwanted changes from becoming permanent and allows for proofing before launching changes.

1.4.1. Style/Design

The style (design) properties for the web map page are included in the same HTML file instead of being stored in a separate CSS stylesheet to reduce potential for errors. To change how the site looks, you need knowledge of CSS coding. All style properties are within the head of the HTML file. Before making any style changes, contact Jessica Richardson at richardson.jessica.lynn@gmail.com for assistance and guidance.

Note: To change the background color, you must change it in each section of the style coding at the top (everywhere background-color is defined) as well as in two sections in the body at the bottom of the HTML file. The sections at the bottom are clearly marked with comment tags reading “CHANGE BACKGROUND COLOR BELOW ALONG WITH ABOVE IN STYLE PROPERTIES”.

1.4.2. Title Bar

To update what is displayed in the title bar of the browser, find the <title> tag. It is located near the top of the HTML file, just below the comment tag reading “EDIT THE TITLE BAR TEXT FOR THE WEB PAGE BELOW”. Change the text between the title tags and save.

1.4.3. Web Page Heading

The text for the heading on the web page is in line 205 below the comment tag reading “EDIT THE WEB PAGE TITLE BELOW”. Change the text between the title tags and save. This needs to be edited annually as it contains the current date range of the data. The best practice for updating this is to update the end year of the date range when new data is imported into the Google Fusion table for a new year.

1.4.4. Start/End Year Selection Options

The area to add/change the selection options for the Start Year starts in line 243 below the comment tag reading “ADD EACH NEW YEAR TO THIS SECTION”. This needs to be edited annually to add the newest year of data to the selection menu. To do this, just add another row to END of the list of “option values” and enter the new year into the text as shown in the following example.

For the year 2012 the new option value line would read:
<option value="2012">2012</option>

Make sure the new date is typed in both places and save; this sets the value to search for within the data table as well as the visible value in the selection menu.
The quotation marks are required for the option value. Also, it is important that each new year is added to the end of the list to maintain a chronological order in the selection menu.

Repeat this process for the End Year. The area to add/change the selection options for the End Year starts in line 275. An easy way to do this is to copy the new option value row added to the Start Year selection options and paste it at the end of the End Year selection options list. Be sure to save your changes.

1.4.5. Other Web Page Text

Other text on the web page includes the instructional text and the link to the Sighting Report Form. These sections are all found in lines 299-306 with comment tags to mark which section changes what. Please refrain from editing the portion that are marked “DO NOT EDIT” (the Sighting Report Form link) without first consulting Jessica Richardson at richardson.jessica.lynn@gmail.com.

To change the text in these sections, alter only what is between the tags (i.e. <div> *edit this part* </div>). To control where the lines break, insert a <br> tag to make the text following the tag to the next line. Save your changes. If you encounter any issues when editing the text, contact Jessica Richardson at richardson.jessica.lynn@gmail.com.

2. The Google Docs

There are two Google Docs that enable the web site and Sighting Report Form to work: a Google Fusion Table linked to the map to provide sightings data, and a spreadsheet connected to the form. These two documents can be found within a folder entitled South Georgia Island Whale Sightings in Google Docs. To gain access to these documents in order to edit/update them, please contact Jessica Richardson at richardson.jessica.lynn@gmail.com.

2.1. Google Fusion Table

A Google Fusion Table is a Google Spreadsheet that is location-enabled; it allows users to identify location information within the spreadsheet to enable quick, easy mapping of the data. The Whale Sightings file in the South Georgia Island Whale Sightings folder is the Google Fusion Table for the web page. Each column within this table is imperative for the functionality of the web page, do not make any changes to the format of the columns or the column names without consulting Jessica Richardson at richardson.jessica.lynn@gmail.com first. Below is a brief description of each column and the data contained in it.

2.1.1. Sighting Date
This column contains the user-entered sighting date. It is used in the sighting details info window in the web map and to determine the year to enter in the startYear and endYear columns (see Section 2.1.2).

2.1.2. startYear and endYear
These columns contain an curator-entered year. It is derived from the year of the user-entered Sighting Date (see Section 2.1.1). The data in these columns is used to query the data contained in the Fusion Table based on sighting year by selecting a start and end year from selection menus on the web page. The values in these two columns should be identical.

Note: These are years although the number formatting in the Google Fusion Table includes a thousands separator making the entries appear to be numbers instead of years.

2.1.3. Species
This column contains the user-entered species of the sighted animal(s). It is used in the sighting details info window in the web map and to query the data in the Fusion Table based on species by selecting a species from the selection menu on the web page.

2.1.4. Number of Animals
This column contains the user-entered number of animals sighted for each instance. It is used in the sighting details info window in the web map.

2.1.5. Longitude (W) and Latitude (S)
These columns include the user-entered coordinates for the sightings. They are used to place the points on the map and in the sighting details info window. Data in these columns should all be negative with decimal points.

2.1.6. Observing Vessel/Observer
This column contains the optional user-entered information about the observing vessel and/or observer. It is used in the sighting details info window in the web map. Many rows may leave this column blank since the data is optional.

2.1.7. Location Description
This column contains the optional user-entered description of the location of the sighting. It is used in the sighting details info window in the web map. Many rows may leave this column blank since the data is optional.
2.1.8. Comments
This column contains the optional user-entered additional comments about the sighting. It is used in the sighting details info window in the web map. Many rows may leave this column blank since the data is optional.

2.1.9. Symbol
This column contains the curator-entered symbol name used to format the points for each species in the map. The information is only used for formatting purposes and is not displayed or queried. See Section 3.4 for more information about the symbol names.

2.2. Google Spreadsheet/Form
The Google Spreadsheet and Form allow collection of new sighting records. The New Whale Sightings spreadsheet in the South Georgia Island Whale Sightings folder is the Spreadsheet/Form for the web page. The form is created from the spreadsheet which links the two; when people fill out the form and submit it, a new row in the spreadsheet is automatically filled in with that data. The spreadsheet contains all the same columns as the Google Fusion Table (See Section 2.1) with an additional first column—Timestamp—that records date/time information about when the data was submitted in the form.

The form can be accessed in multiple ways including emailing the form, visiting the link, and embedding it in a web page. These options are all available in the “Form” menu within the New Whale Sightings spreadsheet and are explained in more detail below.

2.2.1. Emailing the Form
To email the form to users, open the New Whale Sightings spreadsheet and go to Form>Edit form. In the pop-up window, click the option at the top right to “Email this form”. Enter email addresses you wish to email the form to in the box, edit the Subject if desired, and ensure that the box beside “Include form in the email” is checked, then click “Send”. This sends an email version of the form to recipients which allows them to fill out and submit the form from their email without going to the web link.

2.2.2. Visiting the Link
To provide a user with the link, open the New Whale Sightings spreadsheet and go to Form>Go to live form. This takes you to the web version of the form so that you can copy and paste the URL from the address bar and provide it to a user. Alternatively, you can provide the user with the URL for the map web page and direct them to the “Report Sightings” link which will take them to the form.
2.2.3. Embedding the Form in a Web Page
To embed the form in another web page (blog, web site, etc), open the New Whale Sightings spreadsheet and go to Form>Embed form in web page, copy the provided link, and paste into the code for the web page.

3. Checking/Updating Submissions in the Spreadsheet
Once users have submitted data, it needs to be checked for validity and edited to prepare for importing into the Google Fusion Table. Due to formatting capabilities and tools, the best way to do this efficiently is to export the data into MS Excel. To do this, open the New Whale Sightings spreadsheet and go to File>Download as>Excel. This exports the data as an Excel spreadsheet that can be opened and edited in Excel.

To keep up with which records have been checked and updated, highlight all rows yellow after you export the data. (highlight all rows then change the cell background color to yellow. This way, previously updated rows are highlighted in the exported Excel file and rows that will be updated get highlighted for future updates. Before starting to edit the data in the exported Excel file, delete highlighted rows in the file since they have already been checked, edited, and imported into the Google Fusion Table.

In Excel, there are 4 tasks to perform: check for errant data, convert coordinates to decimal degrees, add the startYear and endYear, and add the Symbol.

3.1. Check for Errant Data
To do this, just scroll through the data and check for any entries that seem to be erroneous (e.g. A sighting of 1000 animals, coordinates that are not in the South Georgia Island area, or data of the wrong sort in a cell). If there are erroneous entries, just delete the entire row and continue on.

3.2. Convert Coordinates to Decimal Degrees
In order for the points to be mapped, all coordinates must be given in decimal degrees (e.g. Long: -35, Lat: -55). The form asks for entries to be in decimal degrees but does not prevent other formats from being entered. If coordinates are entered in Degree/Minute/Second format or Degree/Minute format, use the following formulas to convert to decimal degrees. Make sure that ALL coordinates are negative and in decimal degrees!

3.2.1. Degree/Minute/Second to Decimal Degrees
Decimal Degrees = Degree + (Minute/60) + (Second/3600)
3.2.2. Degree/Minute to Decimal Degrees
Decimal Degrees = Degree + (Minute/60)

3.3. Add the startYear and endYear
For each entry, enter the year of the sighting into the startYear and endYear columns. startYear and endYear cells should be identical for each row. This process can be done quickly using Copy and Paste.

3.4. Add the Symbol
For each entry, add the correct symbol name in the Symbol column. Symbols are based upon species and the symbol names for each species are found in the following table:

<table>
<thead>
<tr>
<th>Species</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beaked Whale</td>
<td>measles_brown</td>
</tr>
<tr>
<td>Blue Whale</td>
<td>measles_turquoise</td>
</tr>
<tr>
<td>Fin Whale</td>
<td>small_red</td>
</tr>
<tr>
<td>Hourglass Dolphin</td>
<td>small_yellow</td>
</tr>
<tr>
<td>Humpback Whale</td>
<td>placemark_circle</td>
</tr>
<tr>
<td>Killer Whale</td>
<td>measles_white</td>
</tr>
<tr>
<td>Long-Finned Pilot Whale</td>
<td>small_purple</td>
</tr>
<tr>
<td>Minke Whale</td>
<td>placemark_square</td>
</tr>
<tr>
<td>Sei Whale</td>
<td>measles_grey</td>
</tr>
<tr>
<td>Southern Right Whale</td>
<td>placemark_square_highlight</td>
</tr>
<tr>
<td>Sperm Whale</td>
<td>small_blue</td>
</tr>
<tr>
<td>Unidentified</td>
<td>small_green</td>
</tr>
</tbody>
</table>

If the entry is for an “Other” species, leave the Symbol column blank. These entries are for the purpose of acquiring the data but will not be mapped due to lack of symbol choices.

To complete this task efficiently, sort the data by Species and use Copy and Paste to quickly enter the symbol name for each set of entries by species. Make sure to “Expand the Selection” when you sort the data to prevent the data from becoming mixed up. Once finished, save the changes so the file is ready for import into the Google Fusion Table.
4. Importing New Data into the Google Fusion Table
   After the new data from the New Whale Sightings spreadsheet has been checked and edited in Excel, it can be imported into the Google Fusion Table. To do this, you need to know where the edited Excel file is saved on your computer.

   To import the new data into the Google Fusion Table, open the Whale Sightings table and go to File>Import more rows. In the pop-up, choose “From this computer” on the left then click “Choose file” and navigate to the edited Excel file. Once the file is chosen, click “Next” on the bottom right—it may take a little while to load. If it continues to “load” for a long period of time, click “Cancel” and try again.

   In the next window, uncheck the box above the “Timestamp” column and check the box above the “Symbol” column then click “Finish” to import the new rows. This should take you back to the Whale Sightings Google Fusion Table, which means the rows were imported successfully. To ensure the rows were successfully imported, click “options” at the top, below the menu. In the table options, click the “Filter” tab and select “startYear” from the drop-down menu. In the text box on the right, enter the year of the data you just imported. Once you have entered the filter conditions, click “Apply” and check that your new rows show up.

5. Exporting Google Fusion Table Data for Other Uses
   To export the data in the Google Fusion Table for data analysis or other uses, open the Whale Sightings Google Fusion Table and go to File>Export. This automatically downloads a CSV file containing the data to your computer. If you do not see the file automatically download, check the address bar of your browser for errors or download blocks. The CSV file can be opened and edited using MS Excel, along with many other data analysis programs.